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Technical Support

Symantec Technical Support maintains support centers globally. Technical
Support’s primary role is to respond to specific queries about product features
and functionality. The Technical Support group also creates content for our online
Knowledge Base. The Technical Support group works collaboratively with the
other functional areas within Symantec to answer your questions in a timely
fashion. For example, the Technical Support group works with Product Engineering
and Symantec Security Response to provide alerting services and virus definition
updates.

Symantec’s support offerings include the following:

m A range of support options that give you the flexibility to select the right
amount of service for any size organization

m Telephone and/or Web-based support that provides rapid response and
up-to-the-minute information

m Upgrade assurance that delivers software upgrades

m Global support purchased on a regional business hours or 24 hours a day, 7
days a week basis

m Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our Web site
at the following URL:

www.symantec.com/business/support/
All support services will be delivered in accordance with your support agreement
and the then-current enterprise technical support policy.

Contacting Technical Support

Customers with a current support agreement may access Technical Support
information at the following URL:

www.symantec.com/business/support/

Before contacting Technical Support, make sure you have satisfied the system
requirements that are listed in your product documentation. Also, you should be
at the computer on which the problem occurred, in case it is necessary to replicate
the problem.

When you contact Technical Support, please have the following information
available:

m Product release level
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Hardware information

Available memory, disk space, and NIC information

Operating system

Version and patch level

Network topology

Router, gateway, and IP address information

Problem description:

m Error messages and log files

m Troubleshooting that was performed before contacting Symantec

m Recent software configuration changes and network changes

Licensing and registration

If your Symantec product requires registration or a license key, access our technical
support Web page at the following URL:

www.symantec.com/business/support/

Customer service

Customer service information is available at the following URL:

www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the
following types of issues:

Questions regarding product licensing or serialization

Product registration updates, such as address or name changes

General product information (features, language availability, local dealers)
Latest information about product updates and upgrades

Information about upgrade assurance and support contracts

Information about the Symantec Buying Programs

Advice about Symantec's technical support options

Nontechnical presales questions

Issues that are related to CD-ROMs, DVDs, or manuals
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Support agreement resources

If you want to contact Symantec regarding an existing support agreement, please
contact the support agreement administration team for your region as follows:

Asia-Pacific and Japan customercare_apac@symantec.com
Europe, Middle-East, and Africa semea@symantec.com

North America and Latin America supportsolutions@symantec.com
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Introduction

This chapter includes the following topics:
m About Backup, Archive, and Restore
m About installation and configuration

m About online Help

About Backup, Archive, and Restore

This guide provides basic information about backup and restore procedures for
new users of NetBackup.

Backup, Archive, and Restore is your interface to the NetBackup client software
on your computer. NetBackup lets you back up, archive, and restore files, folders
or directories, and volumes or partitions that reside on your computer.

The computer that needs the backup or restore is the client. The computer that
manages the backup and retrieval of the data is the server.

The Backup, Archive, and Restore interface must be configured to work with your
system. The NetBackup administrator may do that during the installation process.

About backups

Abackup copies the selected items to the destination drive and leaves the original
files on the source drive.

When you start a backup operation, the client software on your computer sends
the data to be backed up to the NetBackup server. The server then writes the data
to a storage device.
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About installation and configuration

About archives

About restores

About policies

About backup i

An archive copies the selected items to the destination drive and then deletes the
items from the source drive, after they are backed up successfully.

When you start an archive operation, the client software on your computer sends
the data to be backed up to the NetBackup server. The server then writes the data
to a storage device and the original files are deleted from the source drive.

A restore retrieves the selected items from the backup images on the server and
restores the selected items to your computer.

When you start a restore operation, the client software on your computer requests
the data from the NetBackup server. The server then sends the data to the client
so it can be restored. The backup images remain on the server.

The NetBackup administrator configures the policies that define the rules that
NetBackup follows when it backs up clients.

The policies include schedules for automatic, unattended backups of the NetBackup
clients (server-directed backups).

Policies also define when you can back up files manually (user-directed backups).

For example, the time range in which you can perform user-directed backups
(your user window) is from 8:00 A.M. to 6:00 P.M.. You cannot back up or archive
at any other time although, you can restore files at any time.

mages

NetBackup stores all of the items that are backed up by a single job in a backup
image. When you restore files, you select the items to restore from a backup image
or from multiple backup images.

Backup images can expire after a certain amount of time (configured by the
NetBackup administrator). If a backup image expires, you cannot see or restore
its files.

About installation and configuration

The NetBackup administrator normally installs and configures Backup, Archive,
and Restore. Installation and configuration include the following:
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m Install and configure the NetBackup client software and the Backup, Archive,
and Restore interface on the computers that are backed up in your computer
environment.

m Configure the client software to work with the NetBackup servers in your
environment.

If user-directed operations are allowed in your NetBackup environment, you
should not have to configure Backup, Archive, and Restore.

If changes to the configuration are needed, contact your NetBackup administrator.

About online Help

This guide provides the basic procedures for backup, archive, and restore tasks.
More information is available in the online Help.

Open the online Help from the Help menu or click on a Help icon in a dialog box.
The following table describes some of the available information in the online Help:

Back up and
archive topics

m Back up and archive types

m User-directed backups

m Server-directed backups

m Full backup

m Cumulative incremental backup
m Differential incremental backup
m True image backup

Restore topics Restore destinations

Restore options

Restoring from specific dates

Restoring from true image backups
Restoring from Veritas Backup Exec backups

Redirecting restores to different clients (administrators only)

Other topics m Procedures to locate the items that you want to restore
m Procedures to specify other backup servers (if allowed in your
environment)
B An interface reference that describes the windows, menus, and
dialog boxes

11
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Getting Started

This chapter includes the following topics:
m About setting up UNIX systems
m About starting Backup, Archive, and Restore

m Backup, Archive, and Restore icons

About setting up UNIX systems

Before you start to use Backup, Archive, and Restore, make sure that your UNIX
environment is set up properly.

On UNIX, Linux, and Macintosh OS X systems, Backup, Archive, and Restore is a
Java-based, graphical user interface.

The following sections describe how to set up your UNIX environment for Backup,
Archive, and Restore:

See “About setting up your UNIX window manager” on page 13.
See “Setting up for Common Desktop Environment (CDE)” on page 14.
See “Setting up for Motif” on page 14.

About setting up your UNIX window manager

Set your window manager so that windows become active only when you click
inside the windows.

Do not enable auto focus, which causes windows to become active if you move the
mouse pointer over them. The NetBackup Java interface does not run properly
with auto focus enabled.
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Other interfaces for UNIX
NetBackup provides additional interfaces for UNIX system:s.

You can perform user-directed operations with the following interfaces. However,
Symantec recommends that you use the Backup, Archive, and Restore interface
for user-directed operations.

Menu User Interface (MUI)  You can use this interface on any terminal that can connect
to a client system. The bp command starts the menu
interface program.

For information about how to use the MUI, refer to the bp
man page and the Help in the interface.

Command-line interface (CLI) Commands let you perform backup, archive, restore
operations from a shell prompt.

For command information, see NetBackup Commands
Reference Guide.

Setting up for Common Desktop Environment (CDE)
For NetBackup Java applications, a CDE window manager is preferred.
Use the following procedure to set up a CDE window manager.
To configure a CDE for Backup, Archive, and Restore
1 Onthe front panel in the CDE window, click the Style Manager icon.
2 On the Style Manager toolbar, click the Window icon.

3 Inthe Style Manager - Window dialog box, click on Click In Window To Make
Active.

Click OK.
When a prompt appears to Restart the Workspace Manager, click OK.

Setting up for Motif
To use the Motif window manager, follow this procedure:
To set up for Motif

& Set the Mum*keyboardFocusPolicy X resource as follows:

Mwm*keyboardFocusPolicy:explicit
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About starting Backup, Archive, and Restore

You can start and run Backup, Archive, and Restore in the following ways:
On a UNIX NetBackup client See “Starting Backup, Archive, and Restore on

UNIX” on page 15.

On a UNIX NetBackup client from a See “Running a NetBackup-Java interface on
Windows computer Windows” on page 16.

On a Windows NetBackup client See “Starting Backup, Archive, and Restore on

Windows” on page 16.

For a description of the Backup, Archive, and Restore interface and directions
about how to use it, see the online Help.

Starting Backup, Archive, and Restore on UNIX

You can use Backup, Archive, and Restore to log into a NetBackup client on a UNIX
system where you have a user account. From Backup, Archive, and Restore you
can perform back ups, archives, and restores on that client.

Note: For information about jbpsa command options, see the jbpsa man page.

To start Backup, Archive, and Restore on UNIX
1 Logintothe computer where you intend to run Backup, Archive, and Restore.

2 To start Backup, Archive, and Restore, enter the following command:

/usr/openv/netbackup/bin/jbpSA &

3 Inthe Login dialog box, enter the name of the client where you want to
perform the backup, archive, or restore.

You must have a valid user account on that client and have access to that
client.

Enter your user name.
Enter your password.

Click Login.
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Running a NetBackup-Java interface on Windows

If the Java Windows Administration Console is installed on a Microsoft Windows
system, you can run the Java Backup, Archive, and Restore interface on it. This
interface lets you log into a NetBackup UNIX or Linux client to perform
user-directed operations on that client.

You must use the Java Windows Administration Console to log on to a UNIX or a
Linux system. You cannot use it to log on to a Windows system.

To start the Java Windows Administration Console

1 Click Start > Programs > Symantec NetBackup > NetBackup - Java Version
7.0.

2 Enter the UNIX client name where you want to perform the backup, archive,
or restore.

You must have a valid user account on that client and have access to that
client.

Enter your user name and your password.

Click Login.

Starting Backup, Archive, and Restore on Windows

Use the following procedure to start the Backup, Archive, and Restore interface
on a Windows system.

To start Backup, Archive, and Restore on Windows systems

1 Click Start > Programs > Symantec NetBackup > Backup, Archive, and
Restore.

2 IfNetBackup Access Management is used to control access to your NetBackup
environment, you may need to enter a user name, password, and domain
information.

Backup, Archive, and Restore icons

Table 2-1 shows the NetBackup icons you may see on the Microsoft Windows
desktop.
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Table 2-1 Backup, Archive, and Restore icons on the Windows desktop

Icon Description

E Represents Backup, Archive, and Restore. It is used in the Windows Start menu
and in Windows Explorer.

E Indicates that the NetBackup Client Job Tracker is running but no backups or
restores are in progress. Used in the system tray.

';- J Indicates that the NetBackup Client Job Tracker is running, and at least one
i restore operation is in progress. Used in the system tray. When the yellow arrow
is blinking, you can open the NetBackup Client Job Tracker for an estimate of

the restore operation.

E Indicates that the NetBackup Client Job Tracker is running, and at least one

backup operation is in progress. Used in the system tray. When the yellow arrow
is blinking, you can open the NetBackup Client Job Tracker for an estimate of
the backup operation.

E Indicates that the NetBackup Client Job Tracker is running, with at least one
backup and one restore in process. Used in the system tray with the yellow
arrows blinking.

Table 2-2 describes the toolbar icons that appear on Windows.

Table 2-2 Backup, Archive, and Restore toolbar icons on Windows

Icon Description

@ Opens a Backup window so you can mark the items you want to back up.

Opens a Restore window so you can mark the items you want to restore.

Opens the View Status dialog box so you monitor the progress of user operations.

Restore window. This feature is available only when a Restore window is open
and it is the active window.

Opens the Troubleshooter.

Opens the Backup, Archive, and Restore online Help.

Y Refreshes or updates the backup images in the NetBackup History pane, in a
! M I
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Table 2-3

Table 2-3

describes the icons that may appear throughout the interface.

Backup, Archive, and Restore icons

Icon

Description

The Backup, Archive, and Restore icon.

The backup icon.

The restore icon.

Represents a floppy drive on Windows.

Represents a CD-ROM or DVD-ROM drive on Windows

Represents a networked drive on Windows.

Represents a client PC on Windows.

Represents a closed directory (folder) that may or may not contain other items.

Represents an opened directory (folder) that may or may not contain other items.

Represents a file or directory (folder) with all of its contents, that is marked for
backup or restore.

Represents a directory (folder) with some of its contents that is marked for
backup or restore.

Represents a file or a directory (folder) that is not marked for backup or restore.

Represents an item with all of its contents that are marked for backup or restore,
but the item itself cannot be marked.

Represents an item with some of its contents that is marked for backup or restore,
but the item itself cannot be marked.

0 F E 08D EaE D

Represents an item that cannot be marked for backup or restore but contains
other items that can be marked for backup or restore.
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Table 2-3 Backup, Archive, and Restore icons (continued)

Icon Description

Represents a directory (folder) in which some of the contents were backed up.

Represents a Java file in the Java GUI on UNIX and Linux.

Represents a Java class file in the Java GUI on UNIX and Linux.

Represents a program file in the Java GUI on UNIX and Linux.

Represents an HTML file in the Java GUI on UNIX and Linux.

Represents a UNIX link in the Java GUI on UNIX and Linux.

Represents a read-only file in the Java GUI on UNIX and Linux.

Represents a text file in the Java GUI on UNIX and Linux.

Represents a file. In Microsoft Windows, other icons may be used to represent
the various file types.

b @B $® O e e

Represents a bitmap, gif, or icon file in the Java GUI on UNIX and Linux.

Represents a backup or restore in progress in the Java GUI on UNIX and Linux.

Represents a successful backup or restore in the Java GUI on UNIX and Linux.

Represents a failed backup or restore in the Java GUI on UNIX and Linux.

Represents the Windows Volume Shadow Copy components on Windows.

Represents the Windows system service on Windows.

Represents the Windows system state on Windows.

Represents the Windows Volume Shadow Copy user data on Windows.

m ¢ E R E O @
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Table 2-3

Backup, Archive, and Restore icons (continued)

Icon

Description

Represents the Windows Volume Shadow Copy data on Windows.

Represents a Windows Volume Shadow Copy writer on Windows.

Represents a Windows Volume Shadow Copy container on Windows.

Represents a Windows Volume Shadow Copy component on Windows.

Represents the entire Windows registry on Windows.

The registry opens to two base keys: HKEY_LOCAL MACHINE and HKEY_USERS.

Represents a registry key on Windows.

Represents the Windows boot files on Windows.

Represents the Windows COM database on Windows.

Represents the entire network on Windows.

Represents a specific network on Windows.

Represents a domain within a network on Windows.

B L ®s s & 0DE S

Represents a backed up, migrated file.




Backing up or archiving

This chapter includes the following topics:

m Backing up or archiving files and directories

Backing up or archiving files and directories

A backup copies items to another drive or a storage device. The original files
remain on the source drive.

An archive also copies items to another drive or a storage device. When the backup
is finished and successful, the original files are deleted from the source drive.

You can back up or archive the following items:

Files

Directories

UNIX and
Linux

Partitions

Files
Folders
Volumes

Windows

Registry keys

System State components

System Service components

EFI System partition (IA64 systems only)
Shadow Copy components

Note: On 1A64 systems, Shadow Copy backups include System State
components and the EFI System partition automatically. If you back
up only System State components, you must also select the EFI System
partition for a successful backup.
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Use the following procedure to perform a user-directed (manual) backup or archive
operation.

For more information about how to use the Backup, Archive and Restore interface,
see the online Help.

To back up or archive with Backup, Archive, and Restore

1 Start the backup as follows, for the appropriate platform:

UNIX and Linux  Click the Backup Files tab.

The space under the menu bar displays the following information
about how NetBackup is currently set up for the operation:

m NetBackup server
m Source client

m Destination client
m Policy type

The following is an example of the Backup Files tab:

Backup, Archive, and Restore [vml] —[ax
T Symantec NetBackup™
File Edit Yiew Actions Help

MNetEackup server Source client Destination client Policy type:
vin2 viml viml Standard

2]

(" Backup Files | Restore Files | Task Progress

Directory Structure 4 @
v @Ay =]
¢ 13 root G Contents of selected directory

o O . chewing i Name [ Size(Bylas) [ Modified [

o[ .dbus |QE inputre 126 12/02j2010 10:50:06 =

o[O3 .2a0cups 10 kde 4096 12/02/2010 06:55:17

: DE-QCW‘; |OB -tesshst 35 09/13/2011 15:36:27

T ECI .g;z:n: |OE tog.uxt. swp 12288 09/13/2011 17:09:09

o« O .gnome2 |\ metacity 4086 12/01/2010 13:55:05

o3 .gnomez _private | mozilla 4096 01/07/2011 13:01:13 |

o O] .gstreamer-0.10 | B3 nautilus 4096 09/27/2011 13:41:37
o[O3 kae “|M( redhat 4096 12/01/2010 13:55:05 =
o= [ . metacity J10lE md 1024 08/17/2011 09:16:52
M0 -rozilla 10 scim 4096 12/02 /2010 06:55:23 —
: 8 .::g;.gs |00 sojanywhere11 4096 12/02/2010 10:21:45
-0 seim || QE acshre 70112/02/2010 10:05:31
o 0100 sqianywhere 11 |00 Trash 4096 12/01/2010 13:55:06
o-[C3 .Trash L _D.verlrtas 4096 12/02/2010 11:58:37
o @0 veritas |OE xauthority 165 09/27/2011 15.06:14 -

o [ Deskiop g
CHI ;;

4]
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Windows To open a Backup window, click File > Select Files and Folders
to Backup or click the Select for Backup icon.

The window title bar displays the following information about
how NetBackup is currently set up for the operation:

m Server
m Client

The following is an example of the backup window:

&% Backup, Archive, and Restore - [Backup: Server: vim?2

W File Edit View Actions Window

Help

Client: vm3]

=181

Blselect for Backup | Bl Select for Restore ~ | Eyview Status | 7] 33 &

E All Folders Contents of C:Y
=08 A Narme [lat. | size | Time Modified |

O 3 config.Msi dsh- 0 9/26/2011 9:19:04 &AM
[ C3Documents and Settings d 0 9/22/2011 2:23:07 PM
OCaProgram Files d=-r 0 7/19/2011 5:02:19 FPM

-] Network O CaProgram Files (x86) d--r 0 7/19/2011 10:13:17 AM

&[] @ Registry O g Public d-- 0 9/1/2011 9:13:02 AWM

-8 System State O CJRECYCLER dsh- 0 8/30/2011 9:51:19 &M

5[], Shadow Copy Components | (] Systern Wolume Information dsh- 0 9/26/2011 11:45:31 PM
O Ly wiNDows d--- 0 9/26/2011 9:20:05 &M
O wmpub c-- 0 £/25/2008 3:35:52 AM
OE14UTOENEC.BAT 0 £/25/2008 3:35:22 &M
O ] boot.ini -sh- 221 £/25/2008 3:18:30 &M
Ol= conrie.svs 0 6/25/2008 3:35:22 AM
OEw.sys -shr 0 £/25/2008 3:35:22 &M
O[=msoos svs -shr 0 £/25/2008 3:35:22 &M
O INTDETECT.COM -shr 47772 3/25/2005 7:00:00 &M
0= riticie -shr 207072 6/25/2008 5:34:18 &M
0= pagefile.sys ~sh- 402653184 0/12/2011 9:16:29 AM

To select the items that you want to back up, in any pane, click the check box

to the left of the item.

A check mark next to individual items indicates that those items are selected.
A check mark next to a directory (folder) indicates that all items in the
directory are selected. A diagonal slash mark next to a directory indicates
that only some items within it are selected.
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Backing up or archiving files and directories

To set up how to back up the selected items, do the following:

UNIX and Linux  Click Backup.

The following is an example of the Backup Files dialog box:

El Backup Files x

NetBackup server
vm2

Files Marked for Normal Backup

Marme

fraat ). metacity
froatf. mozilla
froatf nautilus
froaotf redhat
froat . veritas

Remove from list

[_] Archive files elete files after successful backupy

Keyword phrase to assodate with this backup or archive (optionaly:

Use default progress log filename
Progress log filename

| Start Backup H Cancel

Windows Click Actions > Backup.

The following is an example of the Backup Files dialog box:
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Backup Files | %]

e | NetBackup server: Ivmz LI
iy

General Options l

Files marked for backup:

Name
C:A\Program Filesh

[~ Archive files [delete files after successful backup)

Keyword phrase to associate with this backup or archive (optional):

I

Start Backup I Cancel | Help |

4  Inthe Backup Files dialog box, select or specify any of the following options:

NetBackup server To change the NetBackup server that performs the
backup operation, select a different server from the
drop-down list.

Normally, you do not need to specify a different master
server. If you have the option to send your backups to
more than one master server, be sure that you specify
the correct one.

Remove from list (UNIX The Files Marked for Normal Backup list shows all of

only) the items that you marked for backup. If you want to
remove any item, click on the item and then click this
option.

Archive files (delete files To delete the items automatically from the source drive
after successful backup) after they back up successfully, select this option.

Keyword phrasetoassociate To associate a keyword phrase to the backup, enter

with this backup or archive that information here. When you restore these files

(optional) later, you can search by this keyword phrase for the
backed up items.
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Use default progress log By default, progress log messages are written to the
filename (UNIX only) following location on the UNIX client:

/usr/openv/netbackup/logs/user_ops/loginID/logs

To change the location and the name of the progress
log file for this backup, take the following actions:

m Click this check box to remove the check mark.

m IntheProgresslogfilename field, enter a new path
and file name.

Click Start Backup.

To view the backup progress, do the following

Windows systems: In the View Status dialog box that appears, click Yes.
UNIX systems: In the Task Progress tab that appears, click Yes.
The backup may take a few minutes to complete. After you start a backup

operation, you can close Backup, Archive, and Restore and perform other
tasks. NetBackup continues the operation in the background.



Restoring

This chapter includes the following topics:

m Restoring files and directories

Restoring files and directories

This topic describes how to restore backed up items, as follows:

m From normal or archived backups.

m Individual items from array-based snapshots.

For normal or archived backups, the procedure includes the following tasks:
m Find the items you want to restore.

m Select the destination where you want the items restored.

m Select the appropriate restore options.

m Change the job priority for the restore (optional).

m Change the progress log file name and location (optional-UNIX only).
For other restore types, see the online Help.

To restore files and folders

1 Start the restore, as follows:
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UNIX and Linux ~ m Click the Restore Files tab.

The space under the menu bar displays the following
information about how NetBackup is currently set up for the
operation:
m NetBackup server
m Source client
m Destination
m Policy type

m In the Restore type drop-down list, select either Normal
Backups (default) or Archived Backups.

m Click View > Refresh.

The following is an example of the Restore Files tab:

Backup, Archive, and Restore [logged into vm1]

@ Symantec NetBackup™
File Edit Yiew Actions Help

NetBackup server: Source client Destination client: Policy type:
¥m2 v¥ml viml Standard

(Backup Files | Restore Files | Task Progress

Restore type:

lNarmal Backups lv|
5?.‘2’::? phrase: fl};a,gﬁd?;;'n 16:06:24 Eng?;?a,};hu 23:59:59
Erowse directory: 4
frootf . ’
Directory Structure Contents of selected directory
o O oot B Narne | Backup Date | sizetevtes) | Modified [
o O .chewing —{:|O[3) .bash_history  09/26/2011 16:06:24 10671 09/26/2011 09:30:02 |4
o0 .dbus A0[E) bash_logout 09262011 16:06:24 24 07/12/2006 19:06:42  |=|
o~ [0 .eagcups _ |03 .bash_proiile  09/26/2011 16:06:24 523 05/16/2011 14:24:51
: Bg'gwn:d 10E bashre 09/26/2011 16:06:24 865 05/16/2011 14:37:42
I Dng;Oorr]ne |00 chewing 09j26/2011 16:06 24 12/01/2010 13:55:04
3 C1&8 gnome2_privatdll| QL= .cshre 09/26/2011 16:06:24 100 1270272010 10:05:31
o 001 gnomez |03 s 09/26/2011 16:06:24 01/07/2011 13:00:33 | |
o (O gstreamer-0.14 | +|[E) .dmrc 09/26/2011 16:06:24 26 12/01/2010 13:55:03 |~
o~ [ kde HEl Il | [ ]
7l & Dr—} .metacity Tl & Preview %l Restore...
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m Click File > Select Files and Folders to Restore and select

either from Normal Backup or from Archived Backup.

There may be a delay while NetBackup retrieves the backup
images and builds the list of files that you can restore.

The window title bar displays the following information about
how NetBackup is currently set up for the operation:

m Server

m Source Client

m Destination Client

The following is an example of the restore window

Backup, Archive, and Restore - NetBackup - [Restore: Server: vm2  Client: vm3]

lle Edit Wiew Actions Window Help &) x|
Blselect for Backup | ESelect for Restore = | {@view Status | W @&
i NetBackup History
_'i 2011
E Sep Aug Jul Jun May Apr Mar
s 27 W 21 .. 15 14 13 12 . 8 . 30 29 .4 .14 L 23 2 11 . 19 .. 29
= & 2 2 8 = ¥ ¥ @ @
= &
£
=y All Folders Contents of 'C:\Program Files!
=08 vm3 harme | Time Backed Up | Attributes | Size | Time Modified
=-0=c O common Files 9/26/2011 11:42:46 PM  d-—- 0 9/26/20119:17:14 &M
» OO Configmsi OCcomPlus applications 9/26/2011 3:35:33 PM  d--- 0 6/25/2008 3:31:08 AM
=0 |21 Documents and Settings O Internet Explorer Qf26/2011 2:35:33PM d--- 0 5/19/2011 9:52:42 AM
= 0& Program Files OmMsxmL 6.0 9/26/2011 3:35:33PM  d--- 0 2/23/2010 11:33:28 &AM
=-[ Program Files (x86) O 0outlook Express 9/26/2011 2:35:323 PM  d--- 0 7/15/2011 9:00:28 AM
® O3 Public O ProcessExplorer 9/26/2011 3:35:33PM  d--- 0 7/19/2011 5:01:44 PM
[ RECYCLER O symantec 9/26/2011 3:35:33PM  d--- 0 8/19/2011 11:08:37 &AM
@ [0 System Volume Information Ouninstall Information 9/26/2011 3:35:33 P d-h- 0 4/17/2009 1;01:52 PM
& [10) WINDOWS O Veritas 9/26/2011 11:42:46 PM  d--- 0 9/26/20119:18:31 AM
& 00 wmpub O vmware 9/26/2011 3:35:33PM - 0 B/24/2010 8:50:01 AM
) O windows NT 9/26/2011 3:35:33PM  d--- 0 £/25/2008 3:30:20 &AM
4 | ol

| ol
4

2 Toselect the items that you want to restore, in any pane, click the check box
to the left of the item.

A check mark next to individual items indicates that those items are selected.
A check mark next to a directory (folder) indicates that all items in the
directory are selected. A diagonal slash mark next to a directory indicates
that only some items within it are selected.
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3 Topreview alist of the removable media (such as tape) that NetBackup needs

to perform the restore, do the following:

m On Windows systems, click Actions > Preview Media.

m On UNIX systems, click Preview.

If the items that you want to restore are in backup images that reside on disk
storage units, no media is listed in the preview.

Click OK to close the dialog box

4  To set up how to restore the selected items, do the following:

m On UNIX systems, click Restore.

The following is an example of the Restore Marked Files dialog box:

(® Restore everything to its original location,

Destination:

) Restore individual directories and files to different locations.

. Restore everything 1o a different location (maintaining existing structure).

=] Restore Marked Files x|
General
Destination

Change Selected Destinationds)...
Add Destination...

() Create and restore to a new virtual hard disk file.

Options
[ Overwrite existing files
[] Restore directories without crossing mount points

[] Restore without access- control attributes AYindows dients only)

[ oyerride default priority
Job Priority

(higher number is greater priority)

Use default progress log filename
Progress log filename

Source | Destination | Backup Date | W odified I
Jrooty. bash_history 08/26/2011 160624 08/26/2011 030,02 -
Jrootf bash_logout 09j26/2011 16:06:24 07712/2006 19:06:42
frootf bash_profile 09j26f2011 16:06:24 05716/2011 142451
frootf hashrc 097262011 16:06:24 05716/2011 143742
PP AR AL A EeE S P Ikd

Change All Destinations... |

Remove Selected Destinationds) |

Setting

[ Rename hard links
[] Rename soft links

[J Force rollback even if it destroys snapshots

| sampeswre || cance

m On Windows systems, click Actions > Start Restore of Marked Files.
The following is an example of the Restore Marked Files dialog box:
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Restore Marked Files | x|

General I

r— Restore Destination Choice
(¢ Restore everpthing to its original lacation
"~ Restore everpthing to a different location (maintaining existing structure]

[estination:

C:\Program Files' Browse.., |

" Restore individual folders and files to different locations [double-click to modify)

Solrce | Des{inatianl Time Backed Up I Time Modified
C:\Program FileshSymantech 9/26/2011 335:33PM  819/2011 11:C
C:\Program Files\Veritash, 9/26/2011 11:4246 PM  9/26/2011 91

g | El
" Create and restore to a new virtual hard disk file
Destination for virtual hiard disk file;

— Restore Options

orce roflback even ifiit d
|f the destination file slready exists:
" Dverwite existing files

" Restore the file using a temporary filename:
% Do not restore the file

1Estroys staps

[~ Dverride default job pricrity

Job prionty I‘?DUD] 5

[Higher number is greater prioty]

Start Restare I Cancel | Help

5 Inthe Restore Marked Files dialog box, select from the following options to
meet the requirements for the restore:

Destination Select one of the following destination options:

m Restore everything to its original location (default)
m Restore everything to a different location (maintaining existing
structure)

m Restore individual directories (folders) and files to different
locations

m Createandrestoretoanew virtual hard disk file(Windows systems
only)

For details about each option, see the online Help.
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Restore On UNIX systems, select from the following restore options:

Options

Overwrite existing files.

Restore directories without crossing mount points.

Restore without access control attributes (Windows clients only).
Rename hard links.

Rename soft links.

On Windows systems, select from the following restore options:

Restore without access control attributes (Windows clients only).
Overwrite existing files.

Restore the file using a temporary file name.

Do not restore the file (default).

For details about each option, see the online Help.

Job Priority Youcan change the priority of this restore by clicking Override default
priority, and then set a priority number.

The default is 90000. The available range is 0 to 99999. Higher numbers
are higher priority.

For details about this feature, see the online Help.

Usedefault By default, progress log messages are written to the following location
progresslog on the UNIX client:

file name
(UNIX only)

/usr/openv/netbackup/logs/user ops/loginID/logs

To change the location and the name of the progress log file for this
backup, take the following actions:

Click this check box to remove the check mark.
In the Progress log filename field, enter a new path and file name.
For details about this feature, see the online Help.

Click Start Restore.

To view the restore progress, do the following:

m On Windows systems, in the View Status dialog box that appears, click

Yes.

m On UNIX systems, in the Task Progress tab that appears, click Yes.

The restore may take a few minutes to complete. After you start a restore
operation, you can close Backup, Archive, and Restore and perform other
tasks. NetBackup continues the operation in the background.
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